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IE-45 IM Inputs

Introduction

Congratulations!  With your purchase of the Ivie IE-45, you not only have one of the most powerful, versatile, and
accurate audio spectrum analyzers available, but you also have an analysis system that is capable of expanding
as your needs expand.  The supplied microphone is a Type II microphone, making the standard IE-45, a Type II
measurement system.  For those needing Type I accuracy, two optional microphone preamplifier and microphone
capsule combinations are available to convert the IE-45 analyzer to a Type I measurement system.  With reason-
able care, the IE-45 will provide a long period of useful service.

This manual is intended to familiarize you with the basic operations of the IE-45, and to whet your appetite con-
cerning some of its possibilities.  It is in no way intended to be the total description of all the possibilities of this
unit.

The computer supplied with the IE-45 is a Samsung® Q1, Windows® XP machine.  However, this specific com-
puter is NOT required.  The IE-45 software will run on many Windows® XP machines with USB ports for connec-
tion to the IE-45 Input Module, as long as they have sufficient processing power and speed to run the software at
optimum performance.  If you prefer to use your laptop, for example, simply connect the IE-45 IM to it using an
appropriate USB cable, load the IE-45 software and you’re off and running! 

IE-45 Software Options

A number of different software packages are available for the IE-45.  Each can be purchased separately and run
independently, depending upon your measurement needs.  These software packages include:

IE-45 RTA: Comprehensive real time analysis software.  Comprises multiple functions from RTA to
SPL meter, to oscilloscope, to volt meter and many others.  The bulk of this manual is 
dedicated to a description of the functions of this software package.  Where appropriate, appli-
cations are discussed as well.

IE-45 Leq:  Full Featured Leq survey software.  This independent software package comes with its own
manual and a separate PC software package for formatting and printing measured data. 

IE-45 RT-60: RT-60 measurement software.  This software package runs within the IE-45 RTA software
package, but must be purchased separately.

IE-45 STIPA: Intelligibility measurement software.  This software package runs independently.

IE-45 Record: Independent WAV file recording software.  Recorded WAV files can be injected into the
IE-45 RTA software program for analysis.

Additional software packages will become available in the future as the functionality and measurement capability
of the IE-45 continues to expand.

IE-45 IM Inputs 

As demonstrated across the page, the IE-45 Input Module (IE-45 IM) has four different inputs:  Microphone (Mini
QG, 4-pin), two line level inputs (RCA /phono) and an additional line (SMA) input.  Two of the four inputs can be
simultaneously active.  The variety of input connectors allows for the convenient input of a number of different
signals from external devices.

For those wishing to remote the microphone some distance away from the IE-45, microphone extension cables
of varying lengths up to 200 feet are available from Ivie.
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IE-45 Input  Module  (IE-45 IM)

IE-45 M Microphone.  

The IE-45 M is a Type II, electret microphone.  As
options, the IE-5P Microphone Preamplifier, with the
model 1201, 1/2 inch microphone capsule, or the 
IE-6P Mic Preamp with the 1133, or 1134 air con-
denser capsules are available.   With either of these
options, the IE-45 offers true Type I performance.

Note: The 1/1  octave, 1/3 octave,
1/6 octave and 1/12 octave digital fil-
ters of the IE-45 are Class 0. 

Microphone Input Jack

Switchcraft® Mini QG, 4 pin. 

Mini-B USB Jack 

This connector is used for connecting IE-45
IM to a computer.  The IE-45 IM is self pow-
ered over USB.

Channel 1 and Channel 2 Line Level Inputs 

These inputs are gold plated RCA (Phono) jacks.

These line level inputs are used for measuring 
voltages when employing the Volt Meter function of
the IE-45.  

They are also used when employing the
Oscilloscope function of the IE-45, whether single
trace, dual trace or oscilloscope XY measurements.

Auxiliary Line Input   

This input is a gold plated
SMA connector.  

While not presently
employed in the current 
features of the IE-45, it is
intended for use in future
software packages for the
IE-45 such as vibration
measurement.
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IE-45 Controls

As demonstrated across the page, the IE-45 makes use of a number of different controls, both software and
hardware based.  The controls can be divided into three categories:  1)  Hardware Buttons, 2)  Software Defined
Stylus Buttons and 3)  Pull-down Menus.  Like the stylus buttons, the pull-down menus are touch-activated using
the stylus.

Hardware Buttons  

The IE-45 software defines the use of some of the Samsung® Q1 hardware buttons, as shown across the page.
The “joystick” up/down button can be used, for example, to move the displayed signal up or down on the Q1 dis-
play.  It changes the gain up or down in increments determined by the setting of the dB scale.  The left/right “joy-
stick” button can be used, when the display has been stopped, to move the cursor left or right for selecting a
band of interest.  Frequency and amplitude information is then displayed for the band selected.

Stylus Buttons  

The stylus buttons contain many of the most used features of the IE-45.  They are clearly labeled and very intu-
itive.  Some duplicate the function of hardware buttons, as in the Zoom In and Zoom Out functions, shown in the
illustration across the page.  The stylus buttons allow selection of the RTA display in octave, one third octave,
one sixth octave or one twenty-fourth octave.  The Decay stylus button adjusts the display averaging time.
Successively tapping rotates it from Decay 1, to Decay 2, to Decay 3 and back to Decay 1 again.  Many of the
averaging functions and memory functions are controlled by the stylus buttons.

These buttons also control the functions of the SPL meter, such as switching between A weighted, C weighted
and unweighted measurements, or selecting Fast, Slow, Peak or Impulse measurements.  The use of stylus but-
tons is covered extensively in the sections of this manual dealing with specific IE-45 functions.

Pull-down Menus 

The pull-down menus add tremendous flexibility to the IE-45.  Tapping the "Function" pull-down menu, for exam-
ple, allows you to select one of the many functions of the IE-45.  Choices include RTA, RTA with an LED display
appearance, SPL Monitor, Seat to Seat (SPL variation), Strip Chart function, Polarity measurement, Oscilloscope
function, Signal Generator, Volt Meter and RT-60, if the RT-60 software module has been purchased..

The "Options" pull-down menu allows the setting of display scale and the dB level located center screen (Set dB
Scale).  It also provides for RTA display weighting, allows the display of Peak Hold on the RTA screen, and
allows the selection of NC and NR measurements.  The new “Spectrograph” display can also be selected from
within the “Options” pull-down menu.  Additionally, entering a "Preferred Curve" is possible.  It is also possible to
Play a Test WAV file, or continuously loop through a WAV file (Play Test Loop).  The frequency cursor can be
activated from the “Options” pull-down menu as well, which tracks the highest amplitude on the spectrum ana-
lyzer and indicates the frequency of that highest level.  This can prove extremely useful when chasing feedback
phenomenon.

The menu items in the “Options” pull-down menu are interactive with the “Function” pull-down menu.  As differ-
ent functions are selected, different options for the selected function will appear in the “Options” pull-down menu.



Ivie IE-45 Manual

page 5

IE-45 Controls

Audio Output
Jack:

3/5mm stereo.
Can be used as
a headphone
jack, or as 
the output for the
Signal Generator.

IE-45 Input Module
(IE-45 IM)

IE-45 Microphone:
Microphone shown is the
optional IE-5P with 1201
microphone capsule for
Type I performance.

“Joystick” Button:
It “slides” Left/Right or UP/Down:

Left/Right = Frequency Selection.
Up/Down = dB Range or dB Level.

Zoom In, Zoom Out Hardware
Buttons:

These buttons function like the
Zoom In, Zoom Out Stylus
Buttons.  They change the
dB/Div. which affects the IE-45
display resolution.

Stylus Buttons:
Many of the functions of the RTA and the SPL
Meter are controlled by the Stylus Buttons.
Each function of the IE-45 will have its own set
of Stylus Buttons specific to that function.

Pull-down Menus:
These menus allow
the selection of IE-45
functions and options
within the selected
function.

dB/Division 
Readout

Q1 Power On/Off,
Slider Switch:

Important Note:
Slide to the Right to
turn on.  Sliding Left
brings up Windows®
Media.

Status Window:
Red = Function stopped
by user.
Green = Function run-
ning.  The Status Window
also indicates the micro-
phone selected for use.

Scratch Memory Stylus Buttons: 
Tapping one of these buttons (1 - 9) stores
and displays a memory.  Red indicates an
empty memory.  Green indicates a displayed
memory.  Blue indicates the last memory
manipulated and displayed.  Buff indicates
there is data in a memory, but it is not being
displayed.

Note:  The hardware Button controls for the IE-45 are unique to the Samsung Q1 computer.  If any other com-
puter  is used, the IE-45 RTA Software is not intended to support any hardware button functions.  The hard-
ware buttons of the Samsung Q1 make the operation of the IE-45 more convenient, but they are not required
for operation.  All of the functions of the Q1 hardware buttons are duplicated in the functions of the software
Stylus Buttons.

Sound Pressure Level Readout:
This readout shows SPL to a resolu-
tion of .1 dB, and indicates the SPL
weighting applied.  Tapping the dB
section will cause it to readout volt-
age.  Successive taps will cause the
readout to toggle from volts rms, to
volts pp (peak to peak) and so on,
back to dB SPL

Over Range and
Under Range

Indicator:  
A downward point-
ing arrow here
indicates under
range; an upward
pointing arrow
indicates over
range.  The arrow
is solid while the
conditions exists,
but blinks when
corrected.  It will
continue to blink
until tapped with
the stylus to
remove it.

Save Screen Button:
When tapped, this button saves
a “snapshot” of the IE-45 display
screen.  It is saved to the “My
Documents” folder as a bitmap
(.bmp) file.  It is named “Ivie
Screen” with a number.  Each
successive screen save 
increments to a higher number.
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Getting Started with Your IE-45

If you purchased the  IE-45 complete, you will not need to install the software in the Samsung Q1, or calibrate
the microphone to the unit.  All the software options you purchased will have already be installed and your unit
will have been calibrated and tested.  However, if you purchased just IE-45 IM Input Module, you will need to do
some preliminary work before you can begin using your analyzer.  You are probably already familiar with
installing software on a Windows® XP computer, so the following information will simply confirm what you
already know.

IE-45 Input Module (IE-45 IM)

If you purchased the IE-45 IM with the software packages of your choice, you will need to install the software
packages into the computer you wish to use.  It must be a Windows® XP machine.  The software packages
must be “enabled”  before they will run.  This enabling authorization is stored in the IE-45 IM.  The IE-45 IM will
be shipped to you with each software package you have purchased already enabled.  If you purchase additional
software later, it will need to be enabled.  Included with the software packages is a small software program enti-
tled “Ivie Register.”  You must have your computer connected to the IE-45 IM via a proper USB cable to suc-
cessfully run “Ivie Register.”  This little program will interrogate the IE-45 IM and generate a number on your
computer screen.  That number can be emailed to Ivie (a phone call will work as well).  From that number, Ivie
can generate a second number which you must enter into the “Ivie Register” program to activate the software
package.  This procedure must be followed for each additional software package you purchase.

Important Note: The software package you purchased will be “married”  to your specific IE-45 IM.  It will not
run unless it detects the presence of your IE-45 IM.  However, the software will run on any Windows XP
computer that is properly connected to your IE-45 IM.

Beginning to Use the IE-45

As shown in the illustrations across the page, firing up an IE-45 is simple.  After making sure the USB cable is
properly attached between the IE-45 IM and the Samsung® Q1, (or the computer of your choice), plug in the
microphone.  Turn on the Q1 using the power slide switch.   Slide it to the right, hold it for a moment, then
release it.  Using the stylus, select IE-45 from the menu to begin running the software.  Next, select the function
you wish to use and you're off and running.

Microphone Calibration

Whether you purchased the IE-45 complete, or just the IE-45 IM, the microphone - or microphones, if you pur-
chase more than one - will have already been calibrated to the unit before it left the factory.  The calibration
information resides in the IE-45 IM.  If you purchase another microphone later, you will need to calibrate that
microphone.  For the calibration procedure, consult Appendix I of this manual titled “IE-45 Mic Calibration."

The supplied microphone for the IE-45 is chrome plated in color.  The gold colored microphone of the IE-35 and
the silver colored (clear anodized aluminum) microphone of the IE-33 will not work with the IE-45, even though
they will plug into the IE-45 IM.  The IE-45 uses a higher “phantom” voltage at the microphone input, which will
permanently damage an IE-33 or IE-35 microphone. The chrome colored IE-45 microphone is a Type II, elec-
tret microphone.  Other microphones may be successfully used with the IE-45.  Obviously, whenever a new or
different microphone is used, your unit will need to be recalibrated.  The IE-45 is capable of storing microphone
calibrations for up to six different microphones.  When a different microphone is used, it’s stored calibration
adjustment can simply be selected without having to go through a calibration procedure all over again.

These instrumentation grade microphones are sensitive instruments and should be carefully handled to avoid
damage.
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Step 2

Step 3

Step 1

Getting started is as easy as 1, 2, 3.....

Step 1: Connect the IE-45 IM to the Q1 or
computer of your choice using the 
supplied USB cable and turn on
the computer.

Step 2: Open the IE-45 RTA program.

Step 3: Tap the “Functions” pull- 
down menu and select the
function you wish to use.

You’re off and running!

IE-45 Shown with optional
IE-5P Microphone
Preamplifier and 1201
Precision Microphone for
true Type I performance.
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Real Time Analyzer Controls

Stylus Buttons: The IE-45 is several instruments in the same package:  Real Time Analyzer, Sound Level
Meter, Signal Generator, Oscilloscope etc.  One of their most powerful functions is Real Time Analyzer (RTA).
To make operation simple and intuitive, the most often used controls for the RTA are labeled stylus buttons.  The
illustration across the page shows the stylus buttons associated with the RTA.  Displays of octave, one third
octave, one sixth octave and one twenty-forth octave are selectable as shown.

To set the level at the center of the screen (dB Level) and to adjust the dynamic range of the screen (dB per
Division), tap the "Display" menu.  Next, from the pull-down menu, select "Set dB Scale."  The window shown on
the IE-45 at the bottom of the opposite page shows this feature.  The other functions of the pull-down menus are
covered in detail in other sections of this manual.

Decay:  Display speed (averaging time) is controlled by the stylus button titled “Decay.”  Decay 1 is the fastest
response time available, with Decay 2 somewhat slower and Decay 3 being the slowest.  Decay 3 is intended
for use with pink noise.

Start/Stop Stylus Button: This button stops (freezes) the RTA and SPL displays and starts them again when
tapped a second time.

RTA Display On/Off: The RTA display can be turned on or off using the stylus button illustrated across the
page.  Green button indicates “On,” and brown button indicates “Off.”

Average Display On/Off:  The Average display (when the Average function is active) can be turned on or off
using the stylus button.  Green button indicates “On,” and brown button indicates “Off.”  A red button indicates
the Average function is not active.

Memory Stylus Buttons:  The  IE-45  has 9 “scratch” memories (see the “Memory” section of this manual for
more information on memory and data storage).  To store data in a scratch memory, tap the numbered stylus
button.  A “snapshot” will be stored.  If you are in the Average mode, the average curve will be stored.  When a
memory is empty, its stylus button is red.  Memories with data in them have green stylus buttons when being
displayed and brown when not being displayed.  The last memory stored or activated for display always has a
blue stylus button.  Several memories can be displayed simultaneously and each will have its own color on the
display so it can be differentiated.  

Preferred Curve: The last stylus button in the row of memory status buttons is the memory status button for
“Preferred Curve.”  This is a very powerful function and its use is covered extensively in the section of this man-
ual titled “RTA-Preferred Curve, Display Weighting, LED Display.” 

SPL Readout Stylus Button: Tapping the SPL readout area will cause the analyzer to step through its electri-
cal measurement  modes.  This is very useful for looking at voltage levels simultaneously with spectral content.
Obviously, this feature should be used when measuring electrical signal, not acoustic signals through the mic.

Q1 Buttons:  The IE-45 makes use of some of the buttons found on the  front of the Q1.  Their use is defined
as shown across the page.  The “joystick” up/down function can be used to quickly adjust the display to bring
the signal to the center of the screen.  Either the stylus “Zoom In” and “Zoom Out” buttons, or the two push but-
tons on the right of the Q1 can be used to adjust screen resolution.

Pull-down Menus: Additionally, pull-down menus provide more features and selection capability.  Tapping the
“Function” menu at the top of the screen with the stylus allows the selection of the RTA function.  The various
displays of the RTA function are shown in the illustration across the page.  Below RTA in the Function menu is
“RTA LEDs.”  Selecting this function will provide a display that looks like an LED bar graph that many are so
familiar with.  The advantage of this display is that the screen resolution can be adjusted so each LED repre-
sents 1dB, 2dB or 3dB.  These increments are very useful when equalizing a sound system.
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The RTA can display four different resolutions over its 20 Hz to 20 kHz bandwidth:  1/1 octave, 1/3 octave, 1/6
octave and 1/12 octave.  When a memory is stored, all four resolutions are stored.  This allows a recalled mem-
ory to be viewed or printed in any resolution the user desires.

Zoom in, Zoom out 
Buttons (dB per Div.)

Joystick:  Up/Down controls
dB Center.  Left/Right controls
Frequency Select.

dB/Division Display

RTA & SPL Meter Controls

Store/Recall Memories (1 - 9)Average Display:  On/Off Preferred Curve:  Set/Display

dB Center Line

Average On/Off

SPL Weighting Select

SPL Weighting Readout:
Tap here to change to
Voltage Readout

RTA Display On/Off

RTA Display Start/Stop

SPL Response:  Fast,
Slow, Peak, Impulse

To set dB Center and dB
per Division, tap “Options”
Pull-Down Menu and
select “Set dB Scale.”

1/1 Octave

1/6 Octave 1/12 Octave

1/3 Octave
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Preferred Curve Overlay

The Preferred Curve overlay is an IE-45 feature that allows the user to create a target overlay which can be dis-
played on the screen.  This can be a valuable aid to the equalization process.  Users often use a target curve to
contour the frequency response of a system to a desired result.

Creating a Preferred Curve: The preferred, or target curve, is nothing more than a line created by the user
that is overlaid on the screen to help visualize a desired result.  To create a Preferred Curve, tap the PE memory
stylus button to the far right of the row of memory stylus buttons.  The background on the PE button will change
to white, and the RTA display will move to a special 1/3 octave display with all bars touching the center refer-
ence line. Use the "joystick" button to move the blue 1/3 octave bar right or left to a 1/3 octave you wish to
change, or tap the desired 1/3 octave bar with the stylus.  Use the joystick up/down to change the level of the
1/3 octave.  Move to the next 1/3 octave and change that level, and so on.  You can create a roll-off target curve
or other special spectra targets in this way. 

Tap the Preferred Curve stylus button again and the background will turn green, the button text will change to
PT (preferred target), and the preferred target curve overlay will appear on-screen. Tap the button again and the
background will change to buff while the target curve is removed from the display.  Tap the button again and it
changes to white as the Preferred Curve entry screen again appears so further editing, if desired, can be done.
Tap the button one more time and it turns green while the Preferred Curve is displayed.

Saving a Preferred Curve: The Preferred Curve you have created can be saved to the analyzer memory very
easily.  You can save several Preferred Curves and call them back from memory as needed.  To save a
Preferred Curve, tap the main screen Memory button, which will bring up the Memory Management screen.
Note that the default name of the Preferred Curve is "Preferred.ivi."  Tap the "Store" button immediately to the
right of the file name and you will see a dialog box that allows you to change the name of the file to something
more descriptive (you can also change the file storage location if you wish).  When finished editing, tap "OK" to
store the curve.

Loading a Preferred Curve from Memory:  To load a previously stored Preferred Curve from memory, simply
tap the main screen Memory stylus button to bring up the Memory Management screen.  Memory slot # 9 is
used for storing and recalling Preferred Curves.  Tap the button labeled "Load" for the Preferred Curve memory
location and you will see a dialog that allows you to select the desired preferred curve.  Tap "OK" and the curve
will be loaded into the Preferred Curve memory location.  The IE-45 comes with one pre-loaded Preferred
Curve, labeled "Preferred.ivi" that can be loaded into the display.  It is a high end roll-off curve used as a target
for large venue sound system EQ.

LED Display: Many users are familiar with the LED display of Ivie's IE-30A analyzer.  To have the IE-45 emu-
late the IE-30's LED display, tap the "Function" pull-down menu at the bottom of the main screen and choose
"RTA LEDs."  The RTA display changes to "LEDs.”  Tip: The LED display can be useful in interpreting ampli-
tude information on the analyzer screen.  By setting the dB scale to 5 dB/division each LED represents one dB
of amplitude.  By setting 10 dB/division each LED represents 2 dB of amplitude, and by setting 15 dB/division,
each LED represents 3 dB of amplitude change. 

SPL Weighting and the RTA Display: Some users prefer to see the normal weighting filters that are applied to
SPL measurements also applied to the visual spectrum of the on-screen RTA.  The IE-45 allows you to choose
whether or not the RTA display will show an unweighted display or a weighted display.  To apply weighting filters
to the RTA display, tap on the "Options" pull-down menu at the bottom of the screen and select "RTA Weighting."
Whatever weighting filter is selected for the SPL meter when in RTA mode (the SPL meter is in the small win-
dows in the lower right of the screen) will then be applied to the RTA display.  Unchecking (by again tapping) this
selection will remove weighting from the RTA display.
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Entering a Preferred Curve Overlay

The Preferred Curve Overlay is a valuable aid in the equalization process.   It is the electronic equivalent of draw-
ing a Preferred Cure on the RTA screen with a grease pencil.  The Preferred Curve provides you  with an on-
screen target curve for equalization.

Step 1:  To enter a Preferred Curve, tap the red PE
(Preferred Entry) stylus button.  The Preferred Curve 
Entry screen will appear:

Step 2:  Use the Joystick Left/Right, or the stylus to select
frequency (blue bar) and the Joystick Up/Down to set ampli-
tude until the curve entry is complete.

Step 3:  Tap the “PT” Button to display the Preferred Curve
Overlay.  To turn off the Preferred Curve Overlay, tap the
green PT  Button.  To edit the curve, tap the buff colored PT
button.  Tapping the white PT Button will again display the
edited Preferred Curve.

RTA LED Display

The RTA Display can be set to an LED style display using
the Function Menu.  In this mode, 5 dB/Div = 1 dB/LED, 
10 dB/Div = 2 dB/LED and 15 dB/Div = 3 dB/LED.

Applying “A” or “C” SPL Weightings to the RTA Display (Using the “Options” Pull-Down Menu)

No Weighting Weighting Applied

Preferred Curve Overlay
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Peak Hold Curves

The IE-45 will display peak information in addition to real time information in all of the display modes, 1/1 octave
through 1/12 octave.  The peak curve is shown in violet for the 1/1 octave, 1/3 octave and 1/6 octave displays,
and in white for the 1/12 octave display screen, as shown in the illustration across the page.  The peak curve
data represents the highest levels that have been reached across the spectrum.  In addition to peak data, real
time information is also displayed.

To activate the Peak Hold function and display the peak hold curve, tap the “Options” pull-down menu and select
"Peak/Hold Curve."  You can toggle through the various display formats (1/1 octave to 1/3 octave, etc.) while the
Peak Hold function is active.  However, when selecting different display formats, the peak hold information will
not be preserved from display to display.  Instead, it will initialize and begin again as though it had just been acti-
vated.  To turn the Peak Hold function off, select "Peak/Hold Curve" again.  Note:  If you store spectral data in a
scratch memory when the Peak Hold function is activated, real time data, not the peak curve, will be stored.

Frequency and Amplitude Detection

Several different modes of frequency and amplitude detection are provided by the IE-45.  All of them, including
the Frequency Detect indicator, operate in all resolution settings, 1/1 octave, 1/3 octave, 1/6 octave and 1/12
octave. 

For real time data, a frequency detect cursor can be activated which constantly searches the spectra and dis-
plays the frequency of the highest level found in the spectrum.  Real time data, or peak hold data, can also be
frozen using the "Stop" stylus button, and then be interrogated for frequency information using a provided cursor,
as demonstrated in the illustration across the page.  The cursor can be moved using the stylus or the joy stick.
Additionally, any recalled and displayed memory can be interrogated for frequency information in the same man-
ner.

Frequency Detect: To activate the Frequency Detect mode (especially useful when searching for feedback fre-
quencies), tap the “Options” pull-down menu and select "Freq. Detect."  The Frequency Detect indicator will
appear on screen and begin to search for and identify the frequency registering the highest level.  To turn off the
Frequency Detect indicator, select "Freq. Detect" again. 

RTA Cursor: To activate the RTA Cursor, first tap the stylus button on the bottom left labeled "Stop."  This will
"freeze" the RTA display and the bar below the SPL readout will change from green to red.  Next, press the left
or right joystick.  The  frequency cursor (a red + in 1/12 octave or a green bar in 1/1 octave, 1/3 octave or 1/6
octave) will appear on the curve.  The cursor can be moved left or right using the left and right controls of the
joy-stick, or by using the stylus to tap, and thereby select, a new position.  As the cursor moves, frequency and
amplitude will be indicated in the SPL readout window and all areas of interest can be interrogated.  To turn off
the RTA Frequency Cursor, tap the "Start" stylus button to return the analyzer to its real time display. 

Peak Cursor: When the "Peak Hold Curve" is being displayed, peak hold data can be interrogated using the
Peak Cursor.  To accomplish this, first, turn on the Peak Hold Curve by selecting it from the ”Options” pull-down
menu.  Next, tap the "Stop" stylus button.  When the display has been stopped, select "Peak Cursor" from the
“Options” menu.  The joystick, or stylus, can then be used to move left or right along the spectrum to interrogate
the Peak Curve for frequency and amplitude information.  Selecting "Peak Curve" again turns off this function.

Memory  Cursor: This function works identically to the Peak Cursor.  To activate the Memory Cursor, tap a
memory stylus button to recall the memory of interest.  With the memory display on the IE-45 screen,  tap the
“Options” pull-down menu and select "Memory Cursor."   The Memory Cursor will appear on the curve.  The cur-
sor can be moved left or right along the curve by using the left and right controls of the joystick, or the stylus.  As
it moves, frequency and amplitude will be indicated.  To turn off the Memory Cursor, select "Memory Cursor"
from the “Options” menu again.
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Peak Curve

RTA Curve

Displaying the Peak Hold Curve

To display the Peak Hold Curve, use the “Options” pull-down menu and select “Peak Hold Curve.”  The Peak Hold Curve
will be displayed in white for the 1/12 octave display, or in pink for the 1/1 octave, 1/3 octave and 1/6 octave displays.

Frequency Detect

Frequency Detect has been turned on (using the “Options”
Pull-down menu) for this 1/12 octave display.  The frequen-
cy with the highest amplitude will be indicated.

RTA Cursor

Tapping the Start/Stop cursor button will “freeze” the RTA
display.  The “Joystick” or stylus can be used to select a
band whose frequency and amplitude will be displayed.

Peak Cursor

With the RTA Display “Stopped” and the Peak Hold Curve function turned on, the Peak Cursor can be turned on using the
“Options” pull-down menu.  It will interrogate the peak curve in the same manner that the RTA Cursor interrogates the RTA
Curve.  The Peak Cursor is a green bar for the 1/1, 1/3 and 1/6 octave displays and a red + for the 1/12 octave display.

Peak Cursor
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Memory Functions

The IE-45 memory system provides all the tools necessary to save various types of files to memory, rename
files, load files from memory, examine memory data, and subtract one curve from another.  Most memory sys-
tem operations are performed using the memory stylus buttons and the memory management screen. 

Memory Control Buttons: The memory stylus buttons are located immediately below the RTA display screen. 
The row of twelve buttons allows both control of what is viewed on-screen, and the ability to store data in
"scratch memories."  The far left "R" button toggles "on" or "off" the real time display.  The "A" stylus button 
controls the display of the Average curve.  Stylus buttons 1 - 9 alternately store, remove from display, and
restore to display the contents of the nine Scratch memories.  The "PE" stylus button controls "Preferred" or
"Target Curve" functions.

Stylus Button Colors: If a stylus button is red, there is nothing stored in the memory or display location asso-
ciated with the button.  If the button is green, there is data present and it is being displayed.  Blue is identical to
green, that is, there is data present and it is being displayed.  However, blue also indicates that this is the last
memory location to be manipulated.  This blue color is very useful in keeping memories straight, especially when
several memories have data stored in them.  Finally, if a button is buff colored, there is data stored in that mem-
ory location, but not displayed on-screen (tapping a buff stylus button will display the data associated with that
button and change the button color to blue).

Scratch Memories: Scratch memories are "scratch pad-type" storage memories where you can temporarily
store curve data until you decide to rename and store the data permanently.  You can store the RTA data you
are observing to a scratch memory by tapping a scratch memory stylus button.  Regardless of the resolution set-
ting of IE-45, tapping a scratch memory stylus button saves all resolutions, 1/1 octave, 1/3 octave, 1/6 octave
and 1/12, into scratch memory.

Memory Management: Tap the "Memory" stylus button to access the memory management screen.  The mem-
ory management screen allows you to store, load, and clear files from scratch memories, Preferred Curve mem-
ory, subtraction memory, and peak memory.  Select a memory location you wish to store and tap the adjacent
"Store" button.  You will be prompted to provide a more descriptive name for the file you are about to store.  You
can also change the location to which the file will be stored, if you wish.  Tap "OK" and the contents of the
scratch memory will be stored under the name and in the location of your choice.  To clear a scratch memory
with or without storing it, tap the adjacent "Clear" button.  A stored curve data file may be loaded into a scratch
memory location by tapping the "Load" button, selecting the file to be loaded, and tapping on the file name.
Stored Peak and Subtraction data files may also be loaded into scratch memories.

Subtract Feature: The IE-45 provides a powerful function which allows the user to subtract one curve from
another.  A stored scratch memory curve can be subtracted from the real time display, or one scratch memory
curve can be subtracted from another, or from an Average curve.  Tap the "Subtract" stylus button to access the
subtract control screen.  From here, choose which spectrum you wish to subtract from another.  Upon tapping
"S1 - S2," the RTA display returns with a "0" center reference and blue RTA bars.  You are viewing the one
spectrum subtracted from the other.  To return to normal RTA, tap the Subtract stylus button, then "Cancel."

Peak Storage: When displaying the "Peak Hold" curve in the RTA, you can open the Memory Manager and tap
"Store Peak" to store this peak information in the peak spectrum scratch area.  From here you can rename it
and store it permanently.  Stored peak curve data can be loaded into any of the nine scratch memories via the
Memory Manager.  Just select a scratch memory and tap "Load."   Next, select the peak memory to be loaded.

Memory Files: Data stored in files can be moved to a PC using the standard Microsoft protocol from transfer-
ring data between PC’s.  The analyzer always stores in all resolutions, 1/1 octave, 1/3 octave, 1/6 octave and
1/12 octave regardless of the resolution setting of the IE-45 when the memory was stored.  Using Ivie's supplied
"IvieXLS-45" software, you can display, manipulate, and print data.
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Store a Curve to Memory

To store a curve to memory, tap an empty (red in color)
Scratch Memory stylus button (1-9).  The memory curve will
appear on screen and the stylus button will turn blue, indict-
ing that it contains data and is displaying it.  

If you do not to display the curve, tap the button again.  The
curve will vanish from the screen and the button will turn buff
in color indicating there is data in the memory, but not dis-
played.  Both green and blue mean the data is being dis-
played, but blue indicates it was the last memory to be acti-
vated.  There can be several green and/or buff buttons, but
there can be only one blue one - the last one activated.

To store a Scratch memory to main memory, tap the
“Memory” stylus button to active the memory management
window.

From left to right, the row of memory and display associated
stylus buttons mean:  R = Green; RTA display active. 
A = Red; Average display not on.  1 = Blue;  data in memory
being displayed.  2 - 5 = Buff; data in memory, but not dis-
played.  6 - 9 = Red; memories empty.  PE = Red;  no data
in Preferred Curve Entry memory. 

Storing a Scratch Memory to Main Memory and Loading Data from Main Memory to Scratch Memory

Tapping the red colored “Memory” stylus button brings up the main “Memory Management” window in the center above.
From this window, memories can be cleared, stored or loaded.  Tapping “Store” brings up the window on the left that allows
the storing and naming of memories.  Tapping “Load” brings up the window on the right that allows loading memory files from
the main memory into the various memory locations such as Scratch memory, Preferred Curve memory or Average memory.

Memory Cursor

To use the Memory Cursor, use the “Options” menu and
select Memory Cursor.  Next, tap the “Stop” stylus button to
“freeze” the RTA display.  Use the stylus or the Left/Right
Joystick to select the frequency of interest.

Subtract One Memory from Another and Display Result

To subtract one memory from another and display the result,
first tap the yellow “Subtract” stylus button to bring up the sub-
tract window.  Select the two memories for comparison and tap
“Subtract.”  The “difference” will be displayed in blue.

1.  Select memories for comparison.
2.  Tap “Subtract.”  The blue display

would be “flat” at the 0 dB center
line if the memories were identical.

3.  To exit, tap “Subtract” > “Cancel.”
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NIC Measurements

Sound  transmission field testing of operable walls and field partitions is almost exclusively done using ASTM

E336 as the standard.  The IE-45 is capable of making Noise Isolation Class (NIC) measurements.  NIC meas-

urements are normally specified rather than Field Sound Transmission Class (F)STC measurements because

they are faster, easier, and therefore, less expensive to make.  Field Sound Transmission Class ({F}STC) meas-

urements require RT60 information for the calculation, as well as receiving room absorption in all sixteen 1/3

octave bands of interest.  The IE-45 is capable of making RT60 measurements (if the optional RT60 software

module is purchased) as well as measuring receiving room absorption in the required sixteen 1/3 octave bands.

However, since RT60 measurement capability is an option, not a standard feature, Ivie has chosen not to inte-

grate (F)STC measurement capability into the IE-45 measurement suite.  The following instructions are therefore

limited to the theory of NIC measurements and making  NIC measurements. 

NIC is a single-number acoustical rating of sound isolation between two different spaces separated by a sound

barrier.  A typical measurement example would be determining the sound isolation provided by a wall or mov-

able partition separating two rooms.  To make the measurement, an omni-directional sound source would be

placed in the Source Room to energize it with pink noise.  Averaged (power averaged), 1/3 octave RTA spec-

trum measurements would then be made on both sides of the wall (Source Room and Receiving Room) and

each room average would be stored to separate memory locations.  The NIC calculation would begin as the

stored spectrum of the Receiving Room is subtracted from the stored spectrum of the Source Room to create a

Transmission Loss (TL) curve.

The NIC rating would then be determined by comparing and shifting the TL curve relative to the standard NIC

contour such that the TL curve is never more than 8 dB below the NIC contour in any 1/3 octave band; and the

sum of the deficiencies below the contour over the 16, 1/3 bands, does not exceed 32 dB.  Once the TL curve is

shifted to meet these criteria, the NIC rating is determined by the value of the NIC contour at 500 Hz.  Once the

Source Room and Receiving Room curves are stored, the curve fitting and NIC calculation are all done automat-

ically by the IE-45.  Only a few taps of the stylus are required to complete the measurement and display the

results.

The step-by-step process for making an NIC measurement is demonstrated by the illustrations on the opposite 

page.  Note: Of particular interest in NIC measurements is the requirement for power averaged data.  The

IE-45 “default” operating mode is “Arithmetic Average,” so “Power Average” will need to be selected.

Real Time NIC Measurements 

This is a very useful diagnostic tool offering, unique to Ivie instrumentation.  This mode allows the user to com-

pare the stored average curve in the Source Room to real time data in the Receive Room, thus providing a run-

ning calculation of NIC in real time.  While in the Receive Room, the microphone can be moved to any position

around the sound barrier to find "sound leaks", weak isolation areas, strong isolation spots, etc.  Because the

NIC curve and calculated number are continuously updated in real time, it is easy to quickly compare different

areas, thereby determining deficiencies relative to location. 
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Making an NIC Measurement

Step 1. Select RTA from the Function pull-down menu.
Step 2. Make sure the Average mode is set to power 

average (Average-P).
Step 3. Turn on the sound source in the Source Room.  

With the RTA in Average mode, take several sets of
samples slong the wall (use the Pause/Resume but-
ton)  at a distance of 1 meter.  End by tapping Pause.

Step 4. Store the Average to Memory #1.  Press the Count=
button to clear the Average accumulator.

Step 5. Go to the Receive Room and, from a distance of 1
meter from the wall, gather averaged samples as
in the Source Room.

Step 6. Store the Average you have gathered in Memory #2.
Press the Count= button to exit the Average Mode.

Step 7. Press the yellow Subtract/NIC button to bring up the Subtract/NIC window.
Step 8. In the S1 column, select the number 1 (Memory #1).  In the S2 column, select number 2 (Memory #2).  Next, tap 

the NIC (S1-S2) button. The NIC contour will be displayed and the NIC number will be shown in the SPL window.
Step 9. To exit this measurement display window, tap the NIC (S1-S2) button again, then tap the Cancel button.

For NIC measurements, store the Source Room curve in
Memory #1, and the Receive Room curve in Memory #2.
Next, tap the yellow Subtract/NIC stylus button.

Select Memory #1 from the S1 column and Memory #2
from the S2 column.  Next, press the NIC (S1-S2) button.

Real Time NIC, or “Sniffer” Mode

The IE-45 can perform “Real Time” NIC measurements.  The real time spectrum measurement in the Receive Room is sub-
tracted from the spectrum of the Source Room stored in Memory #1.  This measurement mode is unique to Ivie.  You can
use it as a “sniffer” to help locate leakage paths.

Making a Real Time NIC Measurement

Step 1. Store the Average curve from the Source
Room in Memory #1.

Step 2. Tap the Subtract/NIC stylus button.
Step 3. Select Memory #1 from the S1 column.

Select “R” (Real Time) from the S2 column.
Step 4. Tap the NIC (S1-S2) stylus button.
Step 5. With the IE-45 in this mode, move along the

wall searching for sound leakage points.  You 
can get closer to the wall in this mode, to help
pinpoint problem areas exactly.

Source
Room

Receive
Room
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Average Mode

The IE-45 Average Mode offers very powerful features that allow you to create continuous or triggered
averages of various types, as well as select the type of average that best suits your measurement.

Continuous Average Mode

In the RTA mode, tap on the “Average-A”  stylus button.  The default condition for the stylus button below the
Average button is “Cont.”, which indicates that you will be starting with a continuous average.  When you tap the
Average-A button, the button text changes to “Count = X," where "X" is the number of samples so far collected.
You will see the sample number increment as the number of automatically collected data samples increases. 

A blue line will immediately form on the RTA screen, which is the graphic representation of the average that is
being collected.  The more samples collected, the slower this average display will change as short duration
acoustic events are encountered.

In Continuous Mode, the data sample collection can be paused by tapping Pause/Resume stylus button.
Tapping the stylus button again continues the sample taking process.

You may switch the screen presentation between 1/1 octave, 1/3 octave, 1/6 octave and 1/12 octave at any time
during an Average measurement.  However, doing so will reset the data sample counter to zero and start the
averaging process over again.

Triggered Average Mode

Tapping the “Cont.” stylus button will switch it to “Trigger.”   In this mode, data samples for averaging are taken
only when the user manually triggers a sample.  Triggering a sample can be done by tapping the “Add” stylus
button.  Each time a data sample is added by triggering a sample, the sample count on the Average button will
increment by one.

You can manually clear an Average Curve and reset the data sample counter to zero at any time by tapping the 
“Clear” button.  To exit the Average mode tap the “Count-X” stylus button.

Average Type Selection: The IE-45 Average Mode offers the power of two types of averaging.  The Arithmetic
Average (Average-A) does straight arithmetic averaging.  This type of average is probably best when you are
viewing the RTA screen while doing active equalization, or other dynamic, spectral adjustments.  You may switch
the averaging mode to “Power Average (Average-P), which is probably more useful in measurements where the
total sound power is of prime importance - measurements such as transmission loss, or noise isolation.
Switching from Average-A to Average-P is done by tapping the "File" pull-down menu.  Select "Preferences"
next, and from that menu, select either Power Average or Arithmetic Average.

Viewing an Average Curve: While the average is being taken, the blue average line is seen in the RTA screen. 
To see this line more clearly, you can temporarily remove the real-time data from the display.  This is done by
tapping the green “R” button immediately below the RTA display (see figure on the opposite page).  Don’t forget
to turn the real-time display back on when you’re done . . . It’ll save you a call to Ivie Tech Support!

Storing and Loading an Average Curve: When an Average Curve is displayed on the RTA screen, it is what
will be stored when you choose to store a curve.  With this in mind, an Average Curve is stored in the same way
any other spectrum is stored.  Simply select an empty scratch memory location (red stylus buttons indicate
empty memory locations) and tap it.  The Memory Manager ("Memory" stylus button) allows the storing of any
scratch memory as a file.  Similarly, stored curves can be loaded into any standard scratch memory location by
opening the Memory Manager and selecting “Load” for any of the scratch memory locations.
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Average Mode

The Average Mode of the IE-45 allows taking samples one at a time, or continuously, as desired.  The IE-45 also provides the
ability to do an arithmetic average, or a power average.  To begin an Average measurement, tap the “Average” stylus button.  
Note: The Average button will read “Average-A” if in the arithmetic average mode, or “Average-P” if in the power average
mode.  

The stylus button directly below the Average button allows selection of either continuous (”Cont.”) or “single-shot” (“Trigger”)
measurements.  The next button down allows a pause or resumption of measurement when in the “Continuous” mode, or
adding a single “shot” to the averaging accumulator when in the “Trigger” mode.

“Continuous” Mode Selected “Trigger” Mode Selected 

Green = Average Display On.
Buff = Real-Time Display Off.

With Average Curve displayed, tap an empty (red color)
Scratch Memory to store the Average Curve.

Average Measurement Steps

Step 1. Select either the Continuous (Cont.) or Trigger mode for averaging.  The 
Continuous mode will automatically take sample after sample until the 
“Pause/Resume” button is pressed.  The Trigger mode will take only one
sample each time the “Add” button is pressed.

Step 2. Select either Power Average or Arithmetic Average.  This is done using the
“File” pull-down menu > Preferences > Power or Arithmetic Average.

Step 3. Tap the “Average” stylus button to enter the Average mode.  The “Average”
will be relabeled “Count=X.”   "X” equals the number of samples taken and 
will increment with each tap of the “Add” button, if in the Trigger mode, or will automatically increase as samples are
added, if in the Continuous mode.  Tapping the “Pause/Resume button will pause or restart sample taking.

Step 4. Store the Average Curve, if desired, as shown below.
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Spectrograph Display

An example of the Spectrograph Display is shown across the page.

To select the Spectrograph Display, the IE-45 needs to be in the RTA mode.  The steps to select the
Spectrograph display are:  First, tap “Functions” to activate the Functions pull-down menu.   Select RTA.   Next,
from the “Options” pull-down menu, select “Spectrograph.”

The Spectrograph Display shows frequency along the X axis and time along the Y axis.   At the bottom of the
screen is the strip of color that shows the spectral response as it is occurring.  The next strip up the screen
(going back in time) is the previous measured spectral response.   The strip behind it is the measurement previ-
ous to that, and so on, all the way back in time to the top of the screen. 

The number of strips is controlled by the left/right paddle buttons on the Samsung® Q1 as shown across the
page.   Increasing the number of strips makes each strip more narrow, hence, there are more strips on the
screen.  The range of selection available is from 2 strips to 256 strips on the screen.  The time represented by a
full screen depends upon the number of strips selected.  The middle of the screen thus corresponds to half the
time of a full screen, and is time marked.  For example, a screen marked in the center as “1.5s” would represent
a full screen of 3 seconds of elapsed time between the real time measurement displayed at the bottom of the
screen and the oldest measurement displayed at the top of the screen.  In addition to marking elapsed time, the
information at the center of the screen details the number of strips, half-screen, that have been selected.  Thus,
a marking of “1.5s(64) indicates a full screen of 3 seconds, a half screen (where the marking occurs) of 1.5 sec-
onds and 128 strips of measurement data on a full screen, or 64 strips on a half-screen.  Obviously, increasing
the number of strips displayed increases the full-screen time represented.

Each strip is split into bands whose width depends on the display mode you have selected in RTA - 1/1 Octave,
1/3 Octave, 1/6 Octave or 1/12 Octave.  So, for example, if you have selected 1/1 Octave mode, the strip has 10
bands.  Amplitude in each band is represented by color.  The color is red when the amplitude in that band
exceeds the level indicated by the top of the screen when in standard RTA mode.  The color is blue when the
amplitude is lower than the level at the bottom of the screen in the RTA mode. So, for example, when in the
standard RTA mode you have the scale set so that 50dB is at the bottom and 100dB is at the top, when you
switch to Spectrograph, any band lower than 50dB will show blue, and anything higher than 100 will show red,
with a spectrum range from blue to red in between.

You can, of course, adjust the dB limits while in Spectrograph mode by using the Options Menu and selecting
“Set dB Scale.”  You can also use the Zoom In/Out buttons on the Samsung® Q1.

While in Spectrograph mode you can, as usual, stop the display, or start it again by using the Stop/Start, stylus
button.

Spectrograph Usage

One use of the spectrograph display is to graphically capture short duration, or transient phenomena - such as
cymbal crash, or the sound emitted by an impact hammer.  The spectrograph display allows the exploration of
spectral content of such short duration events.

Another potential application for the spectrograph display is loudspeaker testing.  Feeding an impulse signal into
a loudspeaker while watching the spectrograph display can help identify cabinet resonances, as well as provid-
ing other valuable information. 

Spectrograph displays are routinely used by speech analysts.
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IE-45 Spectrograph Display

In the example above, the spectrograph shown by the IE-45 Spectrograph Display represents an elapsed meas-
urement time of one second.  The center marker window indicates that the measurement bar of data at the cen-
ter of the screen is 0.5 seconds displaced in time from the bottom of the screen (real time).  It also indicates
that the number of measurement bars displayed on the half-scale screen is ten (10), or twenty (20) full screen..

The display is set in the Maximum Resolution mode.  The display range and scale are set using “Set dB Scale”
function found in the RTA “Options” pop-up menu.  Using “Set dB Scale,” the selected display settings are:
60dB center scale and 5dB per division.  This translates to a top-of-the-screen amplitude of 75dB and a bottom-
of-the-screen amplitude of 45dB.  Therefore, any amplitude equal to or below 45dB in a 1/12th octave channel
is shown in blue.  Any amplitude equal to or higher than 75dB in a 1/12th octave band is shown in red.
Amplitudes in between 45dB and 75dB fall into the color spectrum between blue and red.

IE-45 Shown with optional IE-5P Preamplifier
and 1201 microphone capsule for Type I
measurement performance capability.

1201 Microphone Capsule

IE-5P Microphone Preamplifier

Left/right “Joystick” controls the
number of lines displayed on
screen.  The more lines displayed
on the screen, the greater the time
represented by a full screen and the
slower the screen rolls upward.

To select the Spectrograph Display, tap
the “Options” Pull-down menu and then
select “Spectrograph” from the menu.
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Noise Criteria (NC) and Noise Rating (NR) Measurements

The IE-45 is equipped to make quick, accurate Noise Criteria (NC) and Noise Rating (NR) measurements.  NC
and NR are measurement protocols which allow the consultant or contractor to quantify the ambient, or quies-
cent noise level of the room being measured.  Many rooms that are designed by consultants are designed to an
NC or an NR specification, and NC/NR measurements are designed to confirm or certify that the acoustic and
mechanical designs meet the required “level of quiet.”

Making an NC measurement with the IE-45, is very simple.  From the RTA screen, tap on the “Options” pull-
down menu at the bottom of the screen.  Then tap on “NC” to activate the NC measurement screen.  The RTA
screen then automatically configures for NC measurements.  You will note that the IE-45 switches to the one-
octave display and the RTA/SPL weighting reverts to “Flat.”  Both of these settings are required for NC measure-
ments.  You will also notice that the “NC Overlay Contours” are shown on the screen.  These lines represent the
spectral contours that denote the various NC levels.

The NC contours can be “manually read” to determine the NC level.  Making certain that there are no extrane-
ous noise sources in the room (the room should be as quiet as it can be), activate the NC screen.  Determine
the NC line that is closest to, but not touched by, the octave RTA display bars.  This line represents the NC level
of the noise in the room or space being measured.  

Note: NC levels are read in 5 dB increments.  For example, there is technically no such thing as an NC 47.
Only NC 45 or NC 50.  Many individuals, as a matter of practice, refer to NC numbers between the 5 dB levels,
and this can be useful, but it is not technically correct.

The  IE-45 makes the job easier.  Instead of interpreting the movement of the octave bars, you can observe the
NC number which your IE-45 calculates and displays in the lower-right SPL window.  This number will show the
NC measured in 1 dB increments, although the “official” measurements are in 5 dB increments.  To make a “cor-
rect” NC measurement using the NC numbers calculated by the IE-45, one need only round up to the nearest 5
dB increment.

Another Note:  The maximum NC number in the NC protocol is NC 65.  Any level above that does not fit in
the range of NC measurement.  If the noise level of the space being measured is above NC 65, the calculated
NC number will display “NC++”.

NR Measurements are made in exactly the same way NC measurements are made, but the NR Overlay
Contours are slightly different.  Neither NC nor NR is better than the other; they are just slightly differing stan-
dards.  In various regions and countries, one is favored over the other.  The consultant or contractor needs to be
able to measure to both standards in order to meet the needs of both specifications.

To activate the NR measurement screen, go to the “Options” pull-down menu and select “NR.”  From that point,
the instructions for NC and NR are pretty much interchangeable.

NC & NR Averaging: It may be useful to use an averaged octave spectrum for making NC or NR measure-
ments.  To do this, activate the NC or NR screen, then tap the Average button.  Activate the Continuous Average
button (see instructions for Averaging).  The average function will begin taking samples and create a blue aver-
age spectrum line.  When the Continuous Average function is active, NC and NR measurements are being cal-
culated from the relationship of the average octave display (blue line) to the NC or NR Overlay Contours.

If you switch off averaging, the calculated NC or NR number will revert to making its calculations from the real-
time octave bars.

Ivie IE-45 ManualRTA: Noise Criteria & Noise Rating
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Making a Noise Criteria (NC) Measurement

Step 1. While in the RTA Function, select “NC” from the
“Options” menu.  This will  set the RTA weighting to
Octave, unweighted, and bring up the NC contour overlay.

Should you desire, you can activate the Average function.
The NC value will then be calculated from the Average
Curve (note the blue colored NC value, indicating Average).

Should you desire, you can activate the Average function.
The NR value will then be calculated from the Average
Curve (note the blue colored NR value, indicating Average).

Step 2. Read the NR value in the SPL Window.

Note: An NC value over 65 will be displayed as NR++

Making a Noise Rating (NR) Measurement

Step 1. Select “NR” from the RTA “Options” menu.

Step 2. Read the NC value in the SPL Window.

Note: An NC value over 65 will be displayed as NC++
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Sound Level Measurement

Introduction

The decibel (dB) scale has been adopted internationally for use with sound level meter testing.  The scale
begins at a reference of 0 dB in sound pressure level (0 dB SPL) which corresponds to the smallest sound that
can be heard by a healthy human ear, and is equal to 2µN/m2, or perhaps more commonly,  20µPa.  To get a
better idea of relative sound levels, consider the following:  Quiet outdoors in the country would measure around
10dB, a very soft whisper about 30dB and average conversation around 70dB.  An automobile horn would weigh
in at approximately 80dB, a jackhammer around 100dB and a small aircraft engine roughly 120dB.  The thresh-
old of pain is about 140dB.

When studying sound level measurements, it is of major importance to understand the response characteristics
of the human ear.  Our ears do not respond equally to all the frequencies of the audio spectrum - in other words,
they are not "flat" in their response.  To further complicate matters, the response characteristics of human ears
change with different SPL's.  At relatively quiet SPL's, our ears attenuate high frequency sounds to some
degree, and drastically attenuate low frequency sounds.  As SPL's increase, our ears get more efficient at low
frequencies and their response to sound becomes more "flat,"  although they never achieve a totally "flat"   
response.  Following is a set of curves which approximate the "A" and "C" curves, or the hearing response of
human ears.  The "A" curve shows how ears hear, or perceive sound at low SPL's, while the "C" curve shows
how we hear at relatively high SPL's.
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-40

-50

2 20                    50       100                               500       1K                                5K       10K       20K

Frequency in Hz

These curves have been integrated into sound level meters for testing sound levels.  "A" weighted (dBA) meas-
urements use the "A" curve above, "C" weighted (dBC) use the "C" curve above, and "Flat", or “Z” weighted (dB
SPL) measurements use no weighting at all.

Sound Pressure Level (SPL)
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Making SPL Measurements

To make an SPL measurement, turn on the IE-45 and select RTA mode.  Using the SPL stylus button, select the
desired SPL weighting:  “A,” “C” or “Flat”.  Using the other SPL Stylus button, select the desired SPL detector
response:  “Fast,” ”Slow,” “Peak” or “Impulse.”  The application will determine the needed settings.  For example,
noise abatement, or OSHA related measurements will normally be made in Slow, A-weighted.

SPL Weighting Button

The SPL Weighting Button tog-
gles through the suite of 
choices each time it is tapped
with the stylus.  The order of
rotation is:  “Flat,” “A -
Weighted,” “C-Weighted” and
back again to “Flat.”  

In the above example, as can
be seen, the SPL meter is set
to Slow, A-Weighted. 

Notice in the SPL Readout 
window, A-Weighting is desig-
nated by the dB(A) designation.

SPL Response Button

The SPL detector response
toggles through the suite of
choices available each time it is
tapped with the stylus.

The order of rotation for this
stylus button is:  “Fast,” “Slow,”
“Peak,” “Impulse” and back
again to “Fast.”

When “Peak” is selected, the
SPL meter functions in a “Peak
Hold” mode, freezing the high-
est peak SPL measured until a
higher level measurement dis-
places it.

Clearing Peak Hold Readings

When Peak Hold measurement
is selected, the white “Save
Screen” stylus button turns
olive green in color and reads:
“==> RESET.”

Tapping the ==> RESET button
will clear the Peak SPL reading
from the SPL display and allow
a new Peak SPL measurement
to begin.

Exiting “Peak” will automatically
clear the Peak SPL reading
shown in the SPL readout.
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Making SPL Measurements

An IE-45, as shown on the opposite page, can make all the SPL measurements required by U.S. and interna-
tional standards, including A, C and Z (unweighted, or flat) SPL measurements.  In addition to weighting, various
detectors, again specified by U.S. and international standard, can be selected for SPL measurement.  These
detectors include Fast, Slow, Peak and Impulse.  The Fast and Slow detectors are true RMS with different aver-
aging times.  Peak is a true peak detector, and quite fast.  Impulse is a combination of an extremely fast peak
detector, followed by an RMS buffer and is intended for measurement of extremely short duration phenomena.

The Slow detector, in combination with A weighting, is normally used for making sound level measurements
related to noise associated with hearing damage.  OSHA and other regulatory SPL measurements are normally
written around A weighted, Slow.  It has been determined that high A weighted sound levels are more damaging
to human hearing than C or unweighted levels.

System Calibration for OSHA Measurements

OSHA measurements generally require equipment that meets minimum specification standards - at least an
ANSI Type II sound level meter, for example.  The IE-45, with its supplied IE-45M microphone, is a Type II
sound level meter, and therefore satisfies OSHA minimum requirements.  The electronics of the  IE-45 meet
Type I response specifications, however.  With the addition of an optional IE-5P preamplifier and the 1201 micro-
phone, or the IE-6P and a Type I air condenser microphone, the IE-45 becomes a Type I measurement system.

In addition to the equipment meeting minimum specification standards, it must also be properly calibrated in
order for an acceptable OSHA measurement to be made.   What this normally requires is calibration prior to the
measurement, and then a recheck of calibration after the measurement is made.   In the case of SPL measure-
ments, a calibration device (either a pistonphone or an acoustic calibrator) must be used.  The standard IE-45M
microphone is a 10mm diameter, electret condenser microphone.  It can be calibrated with any quality calibration
device that will accept a 10mm adapter (1/2 inch to 10mm adapters are available from Ivie).  Most calibrators
have a larger diameter opening to accommodate microphones up to one inch or slightly larger in diameter, and
have plug-in adapters to reduce the opening size for smaller microphones.  The Ivie Type I microphones, along
with many other international standard air condenser microphones, are 1/2 inch in diameter and require the use
of a 1/2 inch adapter when calibrating.  With either Ivie microphone, the same calibration process applies.  It is
important that the microphone fit snugly inside the adapter to assure accurate readings during calibration.  

For complete information on calibration, see Appendix I of this manual dealing with this subject.

Sound Pressure Level (SPL) Monitor

The IE-45 normally displays SPL readings in the lower-right corner of the display screen, as shown in the illus-
tration across the page.  Immediately below the level readout, the weighting is displayed (A, C or unweighted).
The detector selected is displayed on the blue colored stylus button in the center column of stylus buttons (Fast,
Slow, Peak or Impulse).

There are occasions when a much larger SPL display may be desirable.  The "SPL Monitor" function provides
this.  To access SPL Monitor, tap the "Function" pull-down menu and then tap "SPL Monitor" to activate this
function.  The large SPL display shown across the page will appear.  The SPL at a resolution of 1dB will be dis-
played in very large, easy to see numbers.  The smaller SPL readout in the lower-right of the screen will also
continue to function, providing its .1 dB resolution readout.

There is also a convenient bar graph display shown along with the large numerals.  You can program this bar
graph to change colors at specific sound pressure levels.  To do this, while in the SPL Monitor mode, tap the
"Options" pull-down menu and select “Set dB Levels.”  The level for color change can then be set as shown in
the illustration across the page.  The bar graph and large SPL readout number will change from green to yellow
at the lower level programmed, and from yellow to red at the upper level programmed.  This feature can be
extremely useful in some applications.
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Using the SPL Monitor Mode

The large SPL display of the IE-45 in the SPL Monitor mode, combined with a bar graph that changes colors at
user definable set points, facilitates SPL monitoring of “live sound” events.

The SPL Monitor mode works most effectively when the SPL Meter is set to “Slow.”  This allows convenient
viewing, whereas the “Fast” setting updates the large SPL readout faster than is comfortable for the eyes.
Additionally, A-Weighting is most often used.

Entering Set Points

Step 1. Select “Set dB Levels” from the “Options” menu.
Step 2. Set dB Lower set point (yellow color begins here).
Step 3. Set dB Upper set point (red color begins here).
Step 4. Tap “OK” to exit.

Selecting Weighted or Band Limited Sound 
for Monitoring

Just as with SPL measurement in conjunction with RTA func-
tion, the SPL detectors in the SPL Monitor mode can be set
to “Fast,” ”Slow,” “Peak” and “Impulse.”  The “Peak” mode is
a “Peak Hold” mode, just as it is in the RTA function.  When
in the Peak Hold mode, the white “Save Screen” stylus but-
ton above becomes the ==>RESET button and can be used
to clear the peak reading displayed.

However, in the SPL Monitor mode, octave band amplitudes
can be monitored as well as broadband SPL.  Successively
tapping the blue SPL Weighting stylus button shown above,
will cause it to toggle from “Flat” (broadband), to “A-
Weighted” (broadband), to “250 Hz” (octave), to “4 kHz”
(octave) and back again to the broadband “Flat” setting.

This provides great flexibility in monitoring either broadband
SPL data, or octave band amplitude.

Change Bandwidth Change SPL Detectors
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The large numeral SPL reading reflects the SPL response of the detector selected (Fast, Slow, Peak or
Impulse), and the weighting selected (A weighted, C weighted or Z unweighted).  In addition, the SPL Monitor
function provides level monitoring in octave band levels.  Technically, octave band readings are level measure-
ments and not SPL measurements, since SPL is, by definition, a broad band measurement.

Monitoring of octave band levels is possible in the following octaves:  125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz and
4 kHz.  To select one of these octave centers, tap the green "Weighting" stylus button.  It will toggle with succes-
sive taps from Flat to A weighted, to C weighted, to 125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz and 4 kHz, and back
again to Flat.

Sound Pressure Level (SPL) Seat-to-Seat

One of the highly useful functions of the IE-45 is the measurement of Seat-to-Seat variation.  This function can
be used to measure the uniformity of sound level throughout a venue.  The Seat-to-Seat function allows you to
set a reference level, which then becomes equated to 0 dB.  As you move throughout the venue, level in dB
above or below the reference level is clearly indicated.  As shown in the illustration across the page, Seat-to-
Seat variation is displayed in large numerals.  

Additionally, there is a bar graph that displays Seat-to-Seat variation up to plus or minus 12 dB.  There is also a
numeric readout which displays maximum deviation, the same data as the bar graph, except that it is not limited
to a range of plus or minus 12 dB.  Of course, absolute SPL is also shown immediately above the maximum
deviation readout.

The large numeral SPL reading, as well as the bar graph and the maximum deviation readout, reflect the results
of the detector selected (Fast, Slow, Peak or Impulse), and the weighting selected (A weighted, C weighted or
Flat).  In addition, just as in the SPL Monitor function, the Seat-to-Seat variation function provides level monitor-
ing in octave band levels.  

Monitoring of octave band levels is possible in the following octaves, as shown in the display across the page:
125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz and 4 kHz.  To select one of these octave centers, tap the green
"Weighting" stylus button.   It will toggle with successive taps from Flat to A weighted, to C weighted, to 125 Hz,
to 250 Hz, to 500 Hz, to 1 kHz, to 2 kHz, to 4 kHz and back again to Flat.

Making a Seat-to-Seat Measurement

To make a Seat-to-Seat deviation measurement, tap the "Function" pull-down menu and select "Seat-to-Seat."
Next, with steady-state noise playing in the venue, select a representative spot as the reference.  Once a repre-
sentative spot is located, establish it as the reference by carefully tapping the "Reset" stylus button.  (This
"Reset" reference level will be remembered by the software even if Seat-to-Seat screen is left, but will not be
retained once the analyzer software program has been exited).  Hint: Tapping the "Reset" stylus button roughly
will cause microphonic noise to travel through the unit (like tapping a microphone with your finger) which will ele-
vate the noise level seen by the  IE-45, thus setting a "false" reference level.  Once the reference level has been
set, walking the venue will clearly indicate the level variation at various locations within the venue.  

The type of venue will help determine the settings for the IE-45, when measuring Seat-to-Seat variation.  The
majority of venues will likely be measured in Slow response, as opposed to Fast or Peak.  The bandwidth and
weighting applied are more likely to change from venue to venue.  If the system is intended for music reinforce-
ment, you may want to measure Seat-to-Seat in the Flat mode to assure full-range uniformity from Seat-to-Seat.
You may also wish to measure the same venue A weighted if there are concerns about it meeting local noise or
sound level ordinances, which will likely be written around A weighted measurements.

On the other hand, venues intended primarily for voice reinforcement may likely be "rolled off" on the high end
as well as the low end.  It is not unusual to encounter Seat-to-Seat measurement specifications written around
band limited noise centered at 4 kHz.  The IE-45 meets this requirement nicely.
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Using the IE-45 Seat-to-Seat SPL Function

The Seat-to-Seat function of the IE-45 is intended for use in measuring sound level uniformity over the seating
area of a venue.  Setup of the Sound Level Meter may vary, depending on the type of venue, but the SPL detec-
tor will almost always be set to “Slow” in order to make the display more comfortable for the eye to follow.

In the example below, we will assume that the venue is intended primarily for voice reinforcement, so we will set
up the SPL Meter accordingly:

Step 1. Set the IE-45 Sound Level Meter for “Slow” response and select the 4 kHz octave bandwidth for 
measuring.  We select 4 kHz because speech intelligibility is profoundly effected by accuracy in the 
4 kHz octave bandwidth.  Therefore, this bandwidth is often specified for Seat-to-Seat measurements
for voice reinforcement venues.

Step 2. Energize the sound system with pink noise to a level at least 10 dB above the ambient noise in the
room (20 dB above ambient is even better, if sufficient gain is available).

Step 3. Go to a representative location in the room (two thirds back in the room, slightly to the left of center, is
often suggested).  Press the “Reset” stylus button to set this location as your “0 dB reference point.”
The large readout will say “0.”

Step 4. Quietly walk around the room observing  the information provided by the readout of the IE-45.  Level
variation for area-to-area (seat-to-seat) will be displayed both graphically and numerically.  

Seat-to-Seat variation is graphically
shown by this display.  The “spread”
is easily viewed and simple to under-
stand.

Tapping “Reset” zero’s this display.

Use this stylus button to select the 4
kHz bandwidth.  The button will tog-
gle from“Flat” (broadband), to “A-
Weighted” (broadband), and then
through octave bandwidths from 250
Hz to 4 kHz, and back again to “Flat.”

Seat-to-Seat variation is numerically
displayed by this readout as you walk
the room.

Tapping “Reset” automatically zero’s
this display.

Absolute SPL Value
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Strip Chart

The Strip Chart feature of the IE-45 harks back to the days of pen on strip chart paper.  We still find this type of
visual presentation to be one of the clearest and easiest to “digest” when looking at amplitude over time.  With
Strip Chart, it is possible to record and review variations in amplitude over times ranging from one minute to
eight hours.  Data collected in Strip Chart measurements can be viewed on-screen and/or on the PC, or can be
stored for later analysis.

To begin making a Strip Chart measurement, first select the desired weighting or filtering for the recording.
Unweighted (Z), A, or C weighting may be selected.  Additionally the measurement can be band limited to one of
several octave filters (125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz, or 4 kHz).  This can be useful in crafting a meas-
urement that will be meaningful for the purpose intended.

Next, select the broadband SPL response detector.  The standard Type I SPL detectors (Fast, Slow, Peak and
Impulse) can be selected.  Impulse would rarely be used.  Fast and Peak provide very useful data for analysis,
and Slow would be used for most environmental noise measurements, as many OSHA and other regulatory
measurements specify A weighted, Slow measurements.

The final set-up requirement for making a Strip Chart measurement is to select the length of the recording
desired.  This is chosen by making a selection in “Chart Time” (Options> Chart Time).    Additionally, you can set
visual minimum and maximum indicators with the Set dB Levels (Options > Set dB Levels) boxes.  This gives a
visual indication when levels go above or below the levels you have set, and can be very useful locating "prob-
lem levels" at a glance.  

In the "Options” Pull-down menu, you can also select the vertical display dB/division.  The dB/Div and recording
time are shown in the upper left of the main display window.  

Once all the selections are made, you can “drop the pen” onto the “paper” by tapping “Start.”  It is possible to
stop the recording at any time by tapping “Stop.”  At the end of the designated recording time it will automatically
stop and present a screen to name and store the recorded measurement.

Reviewing a recorded Strip Chart measurement is intuitive.  Follow the directions on the opposing page.
Additionally, the following tips can be very helpful:

Tip #1: 

In addition to using the software “slider” to page through the displayed data, you can also use the sliding “joy-
stick”  to walk the cursor to the left or right on the chart.  When you reach the edge of the screen, the cursor will
“bump” to the next page and reposition itself to the next pixel (it will appear to jump from one side of the screen
to the other) on the chart.

Tip #2: 

When recording a Strip Chart with a longer chart time, you will want to consider the battery life of the Q1 or
other computer you may be using.  Additionally, depending on how you have your computer set up, you may
encounter power management limitations.  Before making extended Strip Chart measurements, check your bat-
tery status to assure you have the necessary operating time available.  Also make sure the power management
settings of your Q1, or other computer, are set such that they will not put your computer “to sleep” before your
measurement is completed.  

Power management settings can be changed using the standard Windows@ XP interface.
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Using the Strip Chart Recorder Function of the IE-45

The Strip Chart Recorder function can be selected from the “Functions” menu.  After accessing the Strip Chart Recorder
function, select the SPL weighting desired and the SPL detector response wanted.  Next, choose the recording time required
by tapping “Options” > “Chart Time” > and then the recording time wanted.  Tap the “Start/Stop”  button to begin recording.

Select Chart Time
from “Options” >

“Chart Time.”

Select SPL
Weighting.

Select SPL
Detector 

Response.

Press the
“Start/Stop”

Button to Begin.

Set Gray Visual areas of Interest
(Minimum/Maximum), using
“Options” >”Set dB Levels”.

Pen is Green
when Recording,
Red when Lifted.

Viewing a Previously Recorded File

When the recording has finished, a “prompt” window will
pop-up allowing you to save the recorded information.  The
recording can be stopped and saved at any time during the
recording process by pressing the “Save Chart” button.

The cursor is controlled by the “Joystick,” or by tapping on
the screen with the stylus.

The Chart is displayed in an expanded form so that each
data point is represented by one pixel.  The slide is used to
“Page” through the data one screen (page) at a time.

Tap to unload the file and return to the Recording screen.

Data at the Cursor point selected.

To view a
saved chart,

tap the
“Load Chart”
button.  The

screen to
the right will

pop-up
allowing you
to select the
proper chart
for viewing.

Scroll through data including:  File name, Test date/time,
Total number of data points, Sample interval, Weighting,
Maximum SPL and time and Minimum SPL and time.

Maximum data point

Minimum data point
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Polarity

The Polarity feature of the IE-45 allows the user to test for the polarity of a loudspeaker with respect to the sig-
nal source, or with respect to other loudspeakers.

Normally, in a correctly wired system, positive voltage on the “+” output of the signal source (amplifier) should
generate outward speaker cone travel (away from the speaker housing and magnet).  More important to the per-
ception of the listener is the uniform polarity wiring of all speakers in a system.

The IE-45 can help the user to quickly test for correct polarity.  In order to test for polarity, a pulse must be gen-
erated and sent through the speakers to be tested.  The IE-45 can generate the special pulse needed to do the
polarity test, though it may be desirable to generate the pulse external to these units (see Tip #2 below).  To
generate the pulse from the IE-45, connect the output (Q1 earphone output = 3.5 mm phone jack) to an input in
signal processing chain going to the speaker system.  From the Polarity screen (Function > Polarity), tap the
“Pulse On” button in the lower part of the screen.  A special pulse will begin to repeat.

In order to make a valid test, the IE-45 microphone should be in the direct field of the loudspeaker.  As you
move the microphone close enough to a loudspeaker to be in the direct field, the Polarity display will show “+”
Positive Polarity, or “-” Negative Polarity, or “- - -” No Lock.  “Positive Polarity” means that the system is wired so
that the loudspeaker is correctly reproducing the output of the amplifier with regard to polarity.  “Negative
Polarity” means the opposite.  “No Lock” means that the microphone is either “confused” because it is not in the
direct field and is seeing too high a level of reverberant energy relative to the direct field, or the overall level of
the speakers is not sufficiently above the room’s noise floor.  These conditions can be corrected by either mov-
ing the microphone closer to the speaker or raising the output level of the loudspeaker.

The most important function of the Polarity test is to assure that multiple loudspeakers in a distributed speaker
system are wired so as to be of uniform polarity.  By starting the pulse signal and then moving from the direct
field of one speaker to the next, the user can quickly confirm that the speakers are correctly wired for uniform
polarity.  The following tips may also prove useful:

Tip #1

When speakers are mounted in a ceiling more than eight feet above the floor, it may not be possible to move the
microphone into the direct field of the speakers when the microphone is mounted to the IE-45 (unless the user is
on stilts!!).  Using a microphone extension cable and a means of elevating the microphone closer to the speak-
ers can provide the solution (a broomstick and some tape works very well!).

Tip #2

Often, using the pulse generated by the IE-45 can be impractical, since a long microphone extension cable, or a
long output cable, or both, might be called for in order to get the pulse signal into the sound system while simul-
taneously moving the microphone close to the speakers.  In most cases it is easier to use a separate pulse
source instead of the IE-45.  There are several ways this can be done.

One way to do this would be to record the pulse and play it back to the sound system with a player.  Another
would be to use the .wav file of the pulse provided on the CD that comes with the IE-45.  

Yet another way would be to use an external generator that creates a pulse that is compatible with the Polarity
feature of the IE-45.  The Neutrik® “Minirator”, for example, generates such a pulse.
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Making a Polarity Measurement

Step 1.  Connect the Polarity Pulse Generator output of the IE-45 (Samsung Q1 headphone 3.5 mm stereo jack)
to the line-level input of the sound system.  Note: The pulse generated by the IE-45 can be recorded 
to a WAV file, or a CD for injection into the sound system if you do not wish to have a cable running 
between your IE-45 and the sound system input.  Also, other compatible signals, such as the one
generated by the Neutrik® Minirator MR1, may be used.

Step 2. Select “Polarity” from the “Functions” menu of the IE-45 and tap the “Pulse On” stylus button to turn on
the pulse.  Adjust the level of the sound system so that it is at least 10 dB above the ambient level in 
room (if sufficient gain is available, 20 dB above ambient is even better).

Step 3. Position the microphone of the IE-45 in close proximity (in the direct field) of the speaker under test.  If
you are too far away from the speaker, the IE-45 may not be able to achieve a “lock” on the polarity.

Step 4.  Read the polarity of the speaker.

In the example screen above, the IE-45 has “locked”
on the signal and identified the polarity of the signal
as “Positive.”

In the example screen above, the IE-45 has “locked”
on the signal and identified the polarity of the signal
as “Negative.”

In the example screen above, the IE-45 is unable to
achieve a “lock” on the signal.  Make certain the
pulse signal level is at least 10 dB above ambient.
Move the microphone closer to the speaker.
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Preferences Menu

Diagnostics

Choosing Diagnostics provides a temporary setting (resets when the application is closed) that changes the
green/red box under the SPL window in the Main Display to show a numerical indication of the measurement
cycle time.  The number represents the time required, in milliseconds, to complete a measurement cycle, as well
as other data.  The Diagnostics setting is not normally displayed, but can help Technical Support Engineers to
better support you if you call the support center.

Power Average / Arithmetic Average

The IE-45 will perform two types of averaging, depending on the type of measurement and preference of the
user.  The default setting is "Arithmetic.”  Power Averaging is most useful when doing transmission loss and
other such measurements where an average of sound power rather than sound level is required.  

1/12 Octave Filter Set On/Off / Limit Display Screen Refresh Rate

Please see Appendiix IV, page 45, for a full explanation of these Preference Menu features.

Oscilloscope (Scope)

The Oscilloscope Function is accessed under the “Functions” menu of the IE-45 and provides a single or dual
channel (dual trace, or XY) audio frequency (20 Hz to 20 kHz) oscilloscope.  The page to the right contains illus-
trations regarding control details.  The oscilloscope is useful in viewing wave forms of various signals.  To use
the oscilloscope function, the "Channel 1”  (Line Level) input must be selected if a single channel oscilloscope
measurement is desired.   If a dual channel measurement is required,  the "Channel 1 & 2 Scope:  XY/Dual
Trace" inputs need to be selected.  Input selection is done in the following manner:

Input Select 

The  Input Select menu is located under the "File" pull-down menu. There are several inputs on the IE-45 (a
microphone connector, two RCA connectors and an SMA connector).  This selection area allows the user to
select the desired input or inputs.  Remember that the IE-45 is a two channel device.  The microphone input and
Channel 1 line input are in parallel - both feed Channel 1.  

The Channel 2 input is line level only.

Dual Trace or XY Measurements

When making dual channel measurements in the oscilloscope mode, either dual trace or XY measurements can
be selected using the "Options" pull-down menu.

Signal Generator

The IE-45 provides a simple signal generator.  The output of the generator is available at the Q1 headphone
jack, and the level of this signal is controlled by the audio level output control of the settings of the Q1 or other
computer you may be using.  Sine, Square, and Triangle wave forms can be selected, as can Pink Noise and
White Noise.  The Main Display in this function shows the waveform of the selected signal type.  See the page
to the right for software controls for the Signal Generator.  In addition to the software slider, frequency can also
be selected with the Q1 "joystick" left/right controls.  Do NOT plug the output of the Q1 into a mic input that
has phantom power active.  The phantom power can blow your audio output.
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Preferences Menu

The “Preference” menu (in the “File” pull-down menu) is
used primarily to select Power or Arithmetic averaging
when the Average function is selected.  

Signal Generator

The output of the Signal Generator is the headphone out-
put of the Samsung Q1.  The output level is controlled by
the headphone volume control of the Q1.

Waveform display of the selected signal source.
Tap to select the type of signal to be generated.

Display of frequency selected by the slider control.
The slider controls the output frequency of the Generator.

Oscilloscope

With Channels 1 & 2 Input selected, the “Options” menu
allows selection of Dual Trace or XY.

This window indicates the selected settings for
Volts/Division and Milliseconds/Division

Use “File” > “Input Select” to select line level input(s).
For Single Trace Scope, use either Channel 1, or 2 input.

For XY/Dual Trace Scope, use “Channels 1 & 2” input.

Use these buttons to vertically position the trace on screen.
Use these buttons to expand/contract waveform vertically.

These buttons expand/contract waveform horizontally.

Single Trace

Dual Trace XY Plot
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Volt Meter

One of the most useful functions of the IE-45 is its ability to measure electrical signals as well as acoustic sig-
nals.  This can be extremely effective for trouble-shooting and system setup.  As an example, pink noise could
be fed into the first component of a sound reinforcement signal chain.  Using an IE-45 a technician, or consult-
ant could step through each of the sound system components.  Levels at inputs and outputs could be measured,
along with the frequency response at every stage.  Crossover points and slopes could be viewed, equalizer
effects noted, level changes assessed and proper signal flow verified.  A wealth of information would be avail-
able by simply probing the electrical inputs and outputs along the signal chain.

The IE-45 is capable of directly measuring preamp level voltages (not to exceed 7.5 volts).  Feeding voltages
higher than 7.5 volts (+19 dBu) directly into an IE-45 could cause damage and void the warranty.  Higher
voltages may be measured only with the addition of an external pad.

Volts RMS

When this mode is selected (see the illustration across the page for visual instructions on selecting various
measurement options), the IE-45 functions as a true RMS volt meter.  Measured voltages are shown simultane-
ously by a digital and an analog display.

Volts Peak-to-Peak (Volts PP)

In this mode, the IE-45 functions as a peak voltage meter.   Measured voltages are shown simultaneously by a
digital and an analog display.

dB Volts (dBV)

When this mode is selected, the IE-45 functions as a volt meter measuring in dB relative to 1 volt RMS.
Measured voltages are shown simultaneously by a digital and an analog display.

dB Volts Unterminated (dBu)

In this mode, the IE-45 functions as a volt meter measuring in dB relative to .775 volts RMS.  Measured voltages
are shown simultaneously by a digital and an analog display.

Nixie Tube Readout

Using the "Options” menu, a more nostalgic Nixie tube digital display can be selected (see the illustration across
the page).  Choosing the Nixie tube readout effects the digital display only.  The analog display continues to
function without change.

Measuring Voltages and Viewing Spectral Information Simultaneously

When "Volt Meter" has been selected using the Function Pull-down Menu, only the voltage measuring displays
shown across the page are available.  If measuring voltages and viewing spectral information at the same time
is desired, this is also possible.

To view spectral content and measure voltages simultaneously, keep the IE-45 in the  spectrum analysis mode.
Next, use the dB SPL readout box as a stylus button.  Successively tapping this button will toggle the IE-45 from
dB (A, C, or Z, depending on what has been selected) to Volts RMS, to Volts Peak-to-Peak, to dB Volts, to dBu
and back to dB SPL.  The dB SPL readout now becomes the Volt Meter readout.

Of course, for this type of measurement, a line input for the IE-45, should be selected.
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Volt Meter

Using the Volt Meter Function of the IE-45

CAUTION - To avoid damage to the IE-45, do not exceed the rated input voltage.

To Use the Volt Meter

Step 1. Under the “Function”
menu, select “Volt Meter.”

Step 2. Under the “File” menu,
select “Input Select” > Channel 1.

Step 3. Connect to the “Channel
1” RCA plug of the IE-45 IM.

Step 4. Tap here to select Vrms,
V peak-to-peak, dBV or dBU.

Measuring in AC Volts RMS.

Measuring in dBV (dB relative to 1 volt rms).

(F) = No Weighting Applied.
(A) = “A” Weighting Applied.
(C) = “C” Weighting Applied.

Measuring in dBu (dB relative to .775 volts rms).

A more nostalgic Nixie tube readout
may be selected from the “Options menu.

Voltage or dB value +++ or --- = over range or under range.

Measuring in AC Volts Peak-to-Peak.
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Calibrating the Microphone of your IE-45

Whichever microphone is calibrated to your IE-45, it is calibrated to the IE-45 Input Module.  The calibration
information “lives” there, not in the computer, so the IE-45 IM remains calibrated even when switching comput-
ers.  The IE-45 IM is capable of storing up to 6 different microphone calibrations, so, if you use more than one
microphone with your unit, you will need to remember to “tell” it which microphone you are using.

Your IE-45 IM was calibrated at the factory for the standard IE-45 M microphone that was supplied with it.  If you
purchased other preamplifier/microphone combinations from Ivie as well, they will have been calibrated to your
IE-45 IM also.

The IE-45 can be calibrated in the field, assuming you have a suitable calibration device (pistonphone or
acoustic calibrator), and can be “manually” recalibrated without a calibration device if you know the “calibration
constant,” as described below:

To calibrate your IE-45, tap the “File”
menu and select “Input Select.”  The
calibration and input selection window
will appear.  It contains instructions for
calibrating with a calibrator.

Just follow the three steps of the
instructions and when finished, tap the
“OK” button to return to the RTA
screen.  Your unit will have been suc-
cessfully calibrated.

This button “hides” the bottom half of
the window - all the calibration informa-
tion.  Tapping it again will restore the
calibration section of the window.

The “Clear” button clears the current
calibration constant.

If your IE-45 should “lose” calibration for some unknown reason, it can be restored without the use of a
calibrator, if you have memorized or recorded your “Calibration Constant.”  

To restore calibration, enter your Calibration Constant in the Calibrator SPL window (use the up/down arrows or
keyboard) and tap the “Manual Set” button.  Calibration will be restored and your Calibration Constant will
appear in the “Constants” window.
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Schematic for Ivie 45MC-25, 25 Foot Extension Cable

Schematic for Microphone Cable:  IE-45 IM to Ivie IE-2P

Schematic for Microphone Cable:  IE-45 IM to Dynamic Microphone

Connect to Ivie
IE-45 M or IE-5P

with 1201
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with 1/2 inch
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Capsule
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Ivie IE-45 IM

Connect to
Ivie IE-45 IM

Connect to
Ivie IE-45 IM

Switchcraft
TA4F

Switchcraft
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A3F

Switchcraft
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+ Vdc
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IvieXLS-45 Instructions 

The IvieXLS-45 software provided with the Ivie IE-45 is actually a template for the Microsoft® Excel® spread-
sheet program.  IvieXLS-45 will function properly with versions of Microsoft Excel version 2000 or newer. 

Before You Start the Software

Before using IvieXLS-45, you will need to transfer the data files of interest that were measured with the IE-45 to
the PC where you have IvieXLS-45 installed.  This can be done using the standard Microsoft protocol for trans-
ferring data from one PC to another.  Once the files of interest have been transferred to your PC, you are ready
to begin using the IvieXLS-45 software.  

Starting IvieXLS-45

When you are ready to start using IvieXLS-45, do not start the Microsoft Excel application!  Instead, you need to
start the IvieXLS-45 template.  The template is the file installed to your computer when you install IvieXLS-45.
That file is named something like “IvieXLS ver. x.x.xls”.  When you start the IvieXLS-45 template, it will automati-
cally start Microsoft Excel.  Note:  If Excel is running when you start IvieXLS-45, the Ivie charting application will
not run properly. You MUST begin your session by starting IvieXLS-45. 

Upon starting up the IvieXLS-45 application, a “permission screen” will pop up which will allow you to “enable
macros.”  You will need to enable macros in order for IvieXLS-45 to operate properly.  If you don't see the
enable macros screen during startup of IvieXLS-45, check the security settings in Excel.  You may need to alter
your security settings.

Once IvieXLS-45 starts, two windows will appear.  The left window is the main chart screen, on which you will
find the graphic depiction of your data.  The right screen is a narrower control screen from which you will be able
to set up the display in the main window.

Control Panel

Most of what you need to know to operate IvieXLS-45 deals with the right-hand control panel shown on the next
page.  Let's examine the control panel, from top to bottom.  When we're done with the control panel, you will
know most of what you need to begin the next step of experimenting with the IvieXLS-45 application itself.

The upper-most panel on the control screen allows you to input the “Current Job Name.”  IvieXLS-45 will
remember that name from session to session and you can change it as needed.  The job name is the descrip-
tion you will choose for the particular measurement, or series of measurements you are making.  It can describe
the measurement itself, or the venue where the measurement is being made, or whatever you want to see on
the chart when you print it out.

The “Edit” panel under Current Job Name is for entering your company information.  The information you put
here will be remembered from session to session, and will print on any of the forms you print using IvieXLS-45.

The next panel down is “Data Sets.”  This is the panel you will use to select the “.ivi” or “.cha” files you wish to
display.  The examples we will use in this instruction set will deal with “.ivi” files, as they are, by far, the most
commonly used. 

“Data sets” are just that.  When you bring a file over from your IE-45, it consists of ASCII, alpha numerical 
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Use to select data files for 
importing from the IE-45.

Use to “overlay,” or match
one curve to another.

Use to “select type of 
plot desired.

Use to enter or edit
current job name.

Use to enter or edit
current job name.

Use to print a displayed plot.

Use to weight a plotted curve.

Use to select a plot center level.

Use to save a data set.

Use to get information about
the version of IvieXLS-45
you are using.

Up to ten different data
sets may be imported.

Use to average two of more
displayed curves together.

Use to subtract one
curve from another.

Use to display the
data numerically.

Use to show NC
or NR overlays.

Use to add identifying
notes to a data set.

Use to select display
resolution.

Use to select plot scale.
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data that numerically represents all of the data recorded in that measurement.  As you'll see a little later in this
document, you can view the raw data as well as the graphical representations thereof.

As you see from the Data Sets panel, you can select up to ten data sets (or curves) to display in the main data
screen at one time.  While having ten curves displayed at one time can, in some cases, be convenient, most
times there would be too much “going on” in the display screen, if you were showing ten curves.  Most users will
find either a single curve, or perhaps two, three, or four curves about right.  Nevertheless, experiment and see
what makes sense for your application.

To select a data file, click on the “Select Data File” button near the bottom of the Data Sets panel.  You will be
presented with a screen that facilitates file selection.  In order to select the first file, click on the “1" button.  You
will be presented with a file navigation screen which will allow you to navigate through your PC's file folders to
find the files you have transported from your IE-45 to your PC.  Select the file of your choice.

As IvieXLS-45 works to create the display of your file, be patient.  IvieXLS-45 is transferring data in four different
resolutions for each “memory” file.  This can take a few seconds, but it allows you to display and print the data in
any resolution:  1/1 octave, 1/3 octave, 1/6 octave or 1/12 octave.

Once you've selected the first file you want to view, you can repeat the process to add other files to be viewed
on the same screen.

Note that you can clear individual files from the control panel, replace files, add additional files, etc.

When you have finished selecting files, click on the “OK” button to come back to the main control panel.

One of the first things you will want to do is select the display resolution of your data.  With the four buttons
immediately below the Data Sets panel, you will be able to select display resolutions of  1/1 octave, 1/3 octave,
1/6 octave, or 1/12 octave.

Note: The data brought across to your PC from the IE-45 consists of four data sets per memory.  All four reso-
lutions are stored and transmitted:  1/1 octave, 1/3 octave, 1/6 octave and 1/12 octave.  The IvieXLS-45 tem-
plate selects the data set for display as you specify.  You can, therefore, look at any curve, in ANY resolution,
even though the curve may have been stored when in the 1/1 octave mode.  It was not just 1/1 octave data that
was actually stored by the IE-45, but all resolutions from 1/1 octave to 1/12 octave.  This stored data, then, can
be viewed in any of the resolutions, either on the IE-45, or on your PC using IvieXLS-45.

Once you have selected the resolution of the display (which you can go back and change at any time), you can
select how you want to plot the information.  “RTA Line” or “RTA Bar” selects how the information will be present-
ed to you; in a line graph or a bar graph.  Depending on the resolution you want, and the purpose for which you
are creating the chart, select the type of display that best suits your needs.

You will note that there is a check box labeled “Average.”  If you have more than one curve on-screen, by check-
ing Average, you can average the curves together to display one averaged curve.  Uncheck the box and you will
go back to the individual displays.

By clicking on the “Delta” button, you are presented with a control screen that allows you to select any two of the
curves you have on-screen (you must have at least two curves on-screen for this feature to be useful) and sub-
tract one from the other.  Just follow steps 1, 2, and 3 on the Delta control panel, then click on the “Plot” button
and you will see the result in the main display area.

Once the Delta curve is displayed, you can still change resolution, bar/line, scaling, etc. When you have the look
you want, you can tap “Print Chart” and print out what is displayed in the main screen.
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When you are finished with the Delta display, simply tap the “Return to Control Panel” button to return to the
main control panel and the main display.  Wait a sec!!!   I've done that (you say) and the Delta display is still
there.  How can I get back to the regular display?  You can't!  (Just kidding) Simply tap any one of the resolution
control buttons on the main control panel and you will be back to the main display.

Curve Matching

Let's talk about “Curve Matching.”  In the course of making measurements in the field you may end up recording
curves of the same source that were measured at different distances from that source.  Later, you may wish to
put these similar measurements on-screen together to see how they compare (to determine HF loss with dis-
tance, or perhaps uniformity of coverage from one location to another, etc.).  But when you do so, there may be
a level difference due to the different distances at which the curves were recorded.

Curve Matching allows you to vertically move one curve with respect to the other on the screen so as to more
closely overlay one on the other.  

To use Curve matching you must have at least two curves on-screen.  Then click on the Curve Matching button.
You will be presented with a Curve Matching control panel.  It is similar to the Delta control panel.  Just follow
steps one and two in order to select the curve you want to be the Master Curve (the one that doesn't move and
becomes the master for the other[s]), and to select the “Curve to Adjust.”

Step three allows you to adjust the one curve relative to the other.  Select Major or Minor adjustment (adjusts the
amount of movement per click of the up/down arrows) and then use the arrows to move the “Curve to Adjust” up
or down to lay it over or “match” the Master Curve.

Tap the “Return to Control Panel” button to return to the main control panel.  Tap any of the resolution buttons to
remove the curve matching and return to the main display.

dB Scale

One of the adjustments you will want to experiment with is “dB Scale” selection.  The dB Scale adjustment
allows you to select 5, 10, or 15 dB per division on the amplitude display of the main screen.  Depending on
what you want to see (details or trends, for example) in your display, you can adjust the dB Scale.  

In the same area of the main control panel you will find “dB Center.”  This allows you to move the displayed
curves vertically on the screen by changing the dB value of the horizontal center line of the main screen display.

NC and NR Displays

NC and NR gives you the ability to display NC (Noise Criteria) or NR (Noise Rating) overlays on-screen.  Read
the IE-45 manual (page 24) for more information on NC and NR measurements.

A and C Weighting

The A Weight and C Weight selection boxes apply A or C weighting to the displayed curve(s).  Sometimes you
may wish to view the curve with weighting applied.

Add Text Label

The “Add Text Label” button brings up a sub control panel which allows you to create a text label and position it
on the main display.  This can be used to make special notes about particular characteristics of a curve, or just
apply a general note on the main screen for printing or display.  The note, or notes can be saved to the XLS file
for future reference.  Note that the “Add Text Label” function is just a simplified way of creating and adding notes.
If one is familiar with Microsoft Excel, the normal methods of adding and locating notes, etc. can be employed.

Ivie IE-45 Manual Appendix III:  IvieXLS-45
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Strip Chart

The “Strip Chart” function in IvieXLS-45 is used to display the special “.cha” files that are created when using the
Strip Chart function of the IE-45.  Tapping the Strip Chart button presents the special control panel for this func-
tion.

Use the “Select Data File” button to open the navigation screen in order to find the “.cha” strip chart file you want
to display.  Select the file and you will view its presentation in the main display window.

Using the “Edit” button in the Strip Chart control panel, you can, if you wish, attach a job name to the display
chart.

Using the Zoom Level control in the Strip Chart control panel, you can choose the number of data points you
want to view per page, and the number of pages or screens you want to view simultaneously on the display.

Use the “Screens Control” to move from one screen to the next.  (The left and right PC keyboard arrows will
also page from screen to screen.  As you are looking at the screen, you will notice a time reference at the bot-
tom of the screen and amplitude reference on the left vertical axis of the screen.

You can also use the “Add Text Label” control to put text notes on the screen to annotate certain events or areas
of interest.

Printing, Saving, Viewing Numerical Data

Finally, you can print the chart or save it with your annotations for later review.  Click on “Return to Control
Panel” to come back to the main control panel. 

Print Chart

“Print Chart” takes you automatically to the print function of your Widows based PC.  Your main display screen
will print.

Save As

“Save As” takes you to a standard Windows screen that will allow you to save your work to a file in the location
of your choice on your hard drive.

Table of Levels

The “Table of Levels” function presents on-screen, the actual numerical data that is used to build the graphic dis-
plays for different resolutions.  This is not the “raw” data, but rather the amplitude data for each of the octave
band resolutions: 1/1, 1/3, 1/6 and 1/12.  In some instances, it can be useful to view the numerical data.  Table
of Levels allows you to do this.

At this point, you should have most everything you need to begin navigating the IvieXLS application.  It will take
some experimentation and practice to determine the best way to format, display and print the data for your spe-
cific requirements.

Appendix III:  IvieXLS-45



Speed and “Horsepower”

Because the IE-45 RTA software is simultaneously running four digital filter sets (octave, 1/3 octave, 1/6 octave
and 1/12 octave) and an FFT (which facilitates the “Frequency Detect” feature), it can be quite CPU intensive.
For those computers with the speed and processing power to handle the RTA software (the Samsung Q1, for
example), this is never a problem.  However, all Windows® XP machines are not created equally.  Even if the
same processor is used by two different machines, there may be, on one of them, hardware features associated
with the processor, or software features that can’t be turned off, which compromise the processor’s capacity to
run the IE-45 RTA software at optimum performance.  This manifests itself as “dropped data” and, in some
instances, degraded display ballistics.

Ivie has added a feature to the software that will never be seen unless data is being dropped.  When this
occurs, a warning window will pop up telling you that data is being dropped and giving you the option to deacti-
vate the 1/12 octave filter set.  The 1/12 octave filter set requires more processor capacity than the other three
sets of filters combined, so disabling it dramatically lowers processor consumption, thus allowing the RTA soft-
ware, with this slightly reduced feature set, to run smoothly on a less-than-optimum computer.  When turned off,
the 1/12 octave filter set processes no data whatsoever and the 1/12 octave display is non-functional.  Once dis-
abled, the 1/12 octave filter set will stay disabled until you make the conscious choice to enable it again.

Of course, you can choose not to disable the 1/12 octave filter set, even though you may occasionally drop data.
This may not be a significant problem.   If, on the other hand, the dropped data warning is constantly appearing
and display ballistics are suffering, corrective action may be a good idea.  

As an option, the display screen refresh rate can be slowed, as detailed below, to help disencumber the CPU.
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Dropped Data

When the IE-45 RTA software detects that data is
being dropped, the warning window shown above
pops up.  This window gives you the option of turning
off the 1/12 octave filter bank, thus allowing the RTA
software to run successfully on a less-than-optimum
computer.

Once disabled, the 1/12 octave filter set will stay dis-
abled until you make a conscious choice to enable it
again.  It can be enabled from the “Preferences”
menu found under the “File” pull-down menu.

The pop-up “Preferences” window also provides for
adjusting the display screen refresh rate, as detailed
by the illustrations to the right.

You can activate (check), or disable (uncheck) the
1/12 octave filter set using the “File” > “Preferences”
Menu.  From this menu, you can also limit (check)
the display screen refresh rate.  This alone, without
disabling the 1/12 octave filters, may be sufficient to
improve the performance of some computer systems.
As shown below, the 1/12 octaves filters are active,
but the screen refresh rate has been limited.

1/12 Octave Filters Off (unchecked)

1/12 Octave Filters On (checked)

Refresh Rate Limited 
(checked) 
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